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About These Instructions 

1 ABOUT THESE INSTRUCTIONS 
These instructions apply to 963 version 3.71. They provide information about installing, upgrading, and licensing 
the 963. 

Other relevant documentation is: 

963 Data Sheet (TA200636) 
963 Engineering Manual (TE200637) 
963 User Guide (TC200635) 
963 Web User Guide (TC200685) 

These documents are available in PDF format in the Documentation directory. 

The 963 uses Open Source Software provided by Third Parties. For more information, refer to "963-open-source-
license.txt" which is available on the DVD as well as in the install directory. 

1.1 Conventions Used in this Manual 
There are numerous items and instructions in this manual, the conventions below are designed to make it quick and 
easy to find and understand the information. 

 Menu commands are in bold type. 
 Buttons and options in dialogue box that you need to select are in bold type. 
 The names of text boxes and dialogue boxes are in bold type. 
 Key combinations that you should press appear in normal type. If joined with a plus sign (+), press and 

hold the first key while you press the remaining one(s). For example CTRL+P indicates holding down the 
control key while pressing P. 

 Text you should enter is in Italic type. 

 For the Touch screen UI, the touch functionality is as explained in the following table: 

To... Do... 
Open the Start screen Windows key. 
Return to the Start screen Lower-left corner and then tap the miniature Start screen 

that appears. 
Left click Tap the option. 
Right-click Press and hold. When a box appears, lift your finger. The 

right-click menu appears. 
Enter values via onscreen key-board Tap the Touch Keyboard button on the taskbar. 
Close the Touch keyboard Tap the X button on the Touch keyboard. 
Move Tap the option and slide it. 
Resize Tap the option, then press and drag the object’s resize 

handle.  
Hover over an item Press and Hold. 

 

1.2 Contacting Trend 
Head Office 

Trend Control Systems Limited 
Albery House 
Springfield Road 
Horsham 
West Sussex 
RH12 2PQ 
England 

Tel: +44 (0) 1403 211888 
Fax: +44 (0) 1403 241608 

Details of regional offices can be found on our Web site. 

Internet 
Our company web site (www.trendcontrols.com) provides information about our products and us. Accredited 
partners should contact our support web site (https://partners.trendcontrols.com). 
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Technical Support 
Our support department provides technical support during normal office hours. Before contacting them ensure that 
you have your Technical Support PIN number available, without this we will be unable to provide you with any 
support. 

Tel: +44 (0) 1403 226600 
Email: trendts@trendcontrols.com 
Fax: +44 (0) 1403 226310 

Technical Publications 
Please send any comments on this or any other Trend technical publication to techpubs@trendcontrols.com. 
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Installation 

2 INSTALLATION 
This section describes how 963 should be installed to ensure that it operates correctly. 963 can be run free of charge, 
for a 28-day trial period but after this a licence must be purchased in order to continue using 963. Before installing, 
or upgrading ensure that the PC meets the system requirements. See the 963 Data Sheet (TA200636). 

If installing 963 on a PC that has a full installation of SQL server earlier than SQL Server 2012 SP2 it is necessary 
to upgrade to SQL Server 2012 SP2. 

If the 963 is to communicate with devices on a BACnet network TOPS must also be installed as described in the 
TOPS Installation Instructions (TG201036). This installation can be on the same PC as 963, or on a different PC 
providing communication is possible between the two over Ethernet. 

963 Clients 
Popup blocking software must be disabled, or configured to allow popups from the 963 Server. 

PC Resources 
963 is a real time application; installed PCs must have enough free resources to safely run 963 under peak load 
conditions. We cannot guarantee system performance if other 3rd party software is installed, for example virus 
checking software. 

File Attributes, compression and encryption 
Windows compression or encryption must not be used for the 963's SQL database, or any other 963 file in the 
project directory also ensure that all files in the project directory have full write access and are not offline. 
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2.1 Installation Procedures 
The process for installing the 963 differs slightly depending on your requirements, and system configuration, you 
should follow the one that matches your needs. 

 Standard Installation - This section describes the standard 963 installation procedure, it should be suitable 
for most installations and should be followed unless your installation is one of the non standard ones 
described below. 

 Installation for use with full version of SQL Server 2012 SP2- This section describes the installation 
procedure if the 963 is to connect to a full version of SQL Server 2012 SP2 on the same PC as 963 instead 
of SQL Server 2012 SP2 Express Edition with Tools. 

 Installation for use with a Remote SQL Server - This section describes the installation procedure required if 
the 963 is to access a remote SQL Server. 

 Installation on an Unsupported Language Version of Windows® - This section describes the installation 
procedure required if the 963 is to be installed on a PC running a Windows® language other than English 
(UK), English (USA), Arabic, Simplified Chinese, Traditional Chinese, Danish, German, Spanish, Finnish, 
French, Italian, Dutch, Polish, Russian, Hebrew, Portuguese, Norwegian, Swedish, or Romanian. 

2.1.1 Standard Installation 

This section describes the standard installation procedure for installing the 963. This procedure should be suitable 
for most installations. When installed as described below 963 will use SQL Server 2012 SP2 Express Edition with 
Tools installed on the same PC as 963, and will access SQL server in Windows Authentication mode. After the 
installation is complete it is strongly recommended that the details in the Engineering manual and Best practice 
security guideline are adhered to. 
 
Standard installation: 

1. Ensure that the PC meets the system requirements. 
2. If required connect the PC to the Ethernet Network as described in the 'Connect the PC to the Ethernet 

Network' section of these instructions. 
3. Install the 963 software as described in the 'Install the 963 Software' section of these instructions. 
4. Log in to Windows as an 'Admin' user, run 963 and licence it as described in the 'Licence 963' section of 

these instructions. 

When the 963 is run for the first time, it displays a password for the System Administrator. This password 
MUST be noted, as without this password it will not be possible to access to the 963. 

5. Connect the GSM modem as described in the 'Connect the GSM Modem' section of these instructions. (963 
SMS Direct only). 

6. Configure the GSM connection as described in the 'Configure the GSM Connection' section of these 
instructions. (963 SMS Direct only). 

7. Connect the PC to the IQ network as described in the 'Connect the PC to the IQ Network' section of these 
instructions. 

8. Check communications as described in the 'Check Communications' section of these instructions. 
9. If users not belonging to the Windows® 'Administrator' workgroup are to run 963 ensure that they have 

access to SQL server as described in the 'Configure the Windows User to have Access to SQL Server' 
section of these instructions. 

After the installation is complete it is strongly recommended that the 963 be configured to automatically 
archive the database as described in the 'Configure Automatic Archiving' section of the 963 Engineering 
Manual (TE200637) and ensure that the DELETEHISTORIC DATA command is executed to prevent the 
database from becoming too large. 
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2.1.2 Installation for use with Full Version of SQL Server 2012 SP2 
This section describes how 963 should be installed for use with a full version of SQL Server 2012 SP2 that is 
installed on the same PC as 963. To carry out this procedure a full version of SQL Server 2012 SP2 is required. This 
must be purchased separately, and is not available from Trend. 

To install 963 for use with a full version of SQL Server 2012 SP2: 
1. Ensure that the PC meets the system requirements. 
2. If required connect the PC to the Ethernet Network as described in the 'Connect the PC to the Ethernet 

Network' section of these instructions. 
3. Install a Full Version of SQL Server 2012 SP2 as described in the 'Install a Full Version of SQL Server 

2012 SP2' section of these instructions. If an earlier version of SQL Server is already installed it must be 
upgraded to SQL Server 2012 SP2. 

4. Configure a Full Version of SQL Server 2012 SP2 as described in the 'Configure a Full Version of SQL 
Server 2012 SP2 ' section of these instructions. 

5. Install the 963 software as described in the 'Install the 963 Software' section of these instructions. 
6. Log in to Windows as an 'Admin' user, run 963 and licence it as described in the 'Licence 963' section of 

these instructions. 

When the 963 is run for the first time, it displays a password for the System Administrator. This password 
MUST be noted, as without this password it will not be possible to access to the 963. 

7. Connect the GSM modem as described in the 'Connect the GSM Modem' section of these instructions. (963 
SMS Direct only). 

8. Configure the GSM connection as described in the 'Configure the GSM Connection' section of these 
instructions. (963 SMS Direct only). 

9. Check communications as described in the 'Check Communications' section of these instructions. 
10. If users not belonging to the Windows® 'Administrator' workgroup are to run 963 ensure that they have 

access to SQL server as described in the 'Configure the Windows User to have Access to SQL Server' 
section of these instructions. 

After the installation is complete it is strongly recommended that the 963 be configured to automatically 
archive the database as described in the 'Configure Automatic Archiving' section of the 963 Engineering 
Manual (TE200637) and ensure that the DELETEHISTORIC DATA command is executed to prevent the 
database from becoming too large. 
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2.1.3 Installation for use with a Remote SQL Server 
This section describes how 963 should be installed for use with a remote SQL Server. 

To install 963 for use with a remote SQL Server: 
1. Ensure that the PC meets the system requirements. 
2. Connect the PC to the Ethernet Network as described in the 'Connect the PC to the Ethernet Network' 

section of these instructions. 
3. Install the 963 software on the appropriate PC (PC 1) as described in the 'Install the 963 Software' section 

of these instructions. 
4. Install the required version of SQL Server on the appropriate PC (PC 2). For details of installing SQL 

Server 2012 SP2 Express Edition with Tools see the 'Install SQL Server 2012 SP2 Express Edition with 
Tools ' section of these instructions. For details of installing a full version of SQL Server 2012 SP2 see the 
'Install a Full Version of SQL Server 2012 SP2' section of these instructions.  

If SQL Server Express is installed it must be upgraded to SQL Server 2012 SP2 Express Edition with Tools 
as described in the `Upgrade to SQL Server 2012 SP2 Express Edition with Tools’ section of this manual.  

If a full version of SQL Server is installed it must be upgraded to SQL Server 2012 SP2 following the 
instructions supplied by Microsoft. 

5. Configure the SQL Server. For details of configuring SQL Server 2012 SP2 Express Edition with Tools see 
the 'Configure SQL Server 2012 SP2 Express Edition with Tools ' section of these instructions. For details 
of configuring a full version of SQL Server 2012 SP2 see the 'Configure a Full Version SQL Server 2012 
SP2' section of these instructions. 

6. Ensure that the PC running 963 (PC 1) and the PC running SQL Server (PC 2) are set up on the same 
network or domain. 

7. Create a directory on PC 2 that is the same as directory 963 is installed in on PC 1 (normally c:\program 
files\trend control systems\963) on PC 2. 

8. Log in to Windows as an 'Administrator' user, run 963 and licence it as described in the 'Licence 963' 
section of these instructions. 

When the 963 is run for the first time, it displays a password for the System Administrator. This password 
MUST be noted, as without this password it will not be possible to access to the 963. 

8. Configure the 963 to Connect to a Remote SQL Server as described in the 'Configure 963 to Connect to a 
Remote SQL Server' section of these instructions. 

9. Restart 963. The 963 will create an empty database on the remote SQL Server PC (PC 2). 
10. Connect the GSM modem as described in the 'Connect the GSM Modem' section of these instructions. (963 

SMS Direct only). 
11. Configure the GSM connection as described in the 'Configure the GSM Connection' section of these 

instructions. (963 SMS Direct only). 
12. Connect the PC to the IQ network as described in the 'Connect the PC to the IQ Network' section of these 

instructions. 
13. Check communications as described in the 'Check Communications' section of these instructions. 
14. If users not belonging to the Windows® 'Administrator' workgroup are to run 963 ensure that they have 

access to SQL server as described in the 'Configure the Windows User to have Access to SQL Server' 
section of these instructions. 

After the installation is complete it is strongly recommended that the 963 be configured to automatically 
archive the database as described in the 'Configure Automatic Archiving' section of the 963 Engineering 
Manual (TE200637) and ensure that the DELETEHISTORIC DATA command is executed to prevent the 
database from becoming too large. 
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2.1.4 Installation on an Unsupported Language Version of Windows 
This section describes how 963 should be installed on a PC running a Windows language other than English (UK), 
English (USA), Arabic, Simplified Chinese, Traditional Chinese, Danish, German, Spanish, Finnish, French, Italian, 
Dutch, Polish, Russian, Hebrew, Portuguese, Norwegian, Swedish, or Romanian. 

To install 963 on an unsupported language version of Windows®: 
1. Ensure that the PC meets the system requirements. 
2. If required connect the PC to the Ethernet Network as described in the 'Connect the PC to the Ethernet 

Network' section of these instructions. 
3. Install SQL Server 2012 SP2 Express Edition with Tools as described in the 'Install SQL Server 2012 SP2 

Express Edition with Tools' section of these instructions. 
If an existing version of SQL Server Express is installed it must be upgraded to SQL Server 2012 SP2 
Express Edition with Tools as described in the `Upgrade to SQL Server 2012 SP2 Express Edition with 
Tools` section of this manual. 

4. Configure SQL Server 2012 SP2 Express Edition with Tools as described in the 'Configure SQL Server 
2012 SP2 Express Edition with Tools ' section of these instructions. 

5. Install the 963 software as described in the 'Install the 963 Software' section of these instructions. 

6. Log in to Windows as an 'Administrator' user, run 963 and licence it as described in the 'Licence 963' 
section of these instructions. 

When the 963 is run for the first time, it displays a password for the System Administrator. This password 
MUST be noted, as without this password it will not be possible to access to the 963. 

7. Connect the GSM modem as described in the 'Connect the GSM Modem' section of these instructions. (963 
SMS Direct only). 

8. Configure the GSM connection as described in the 'Configure the GSM Connection' section of these 
instructions. (963 SMS Direct only). 

9. Connect the PC to the IQ network as described in the 'Connect the PC to the IQ Network' section of these 
instructions. 

10. Check communications as described in the 'Check Communications' section of these instructions. 
11. If users not belonging to the Windows® 'Administrator' workgroup are to run 963 ensure that they have 

access to SQL server as described in the 'Configure the Windows User to have Access to SQL Server' 
section of these instructions. 

After the installation is complete it is strongly recommended that the 963 be configured to automatically 
archive the database as described in the 'Configure Automatic Archiving' section of the 963 Engineering 
Manual (TE200637) and ensure that the DELETEHISTORIC DATA command is executed to prevent the 
database from becoming too large. 
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2.2 Connect the PC to the Ethernet Network 
If the 963 is to connect to the IQ network over Ethernet, is act as a server providing BMS information to clients, or 
if access to company IT information such as the company Intranet, or the Internet is required, the PC must be 
connected to an Ethernet network. Connection in this way does not prevent connection to the IQ network over the 
Ethernet. 

To connect the PC to the Ethernet network: 
1. If necessary fit a suitable Ethernet adaptor to the PC, following the manufacturer’s instructions. 
2. If connection is to be made using a wireless network necessary configure the device to connect to the 

wireless network, otherwise plug the Ethernet network cabling into the Ethernet adaptor. 
3. Configure Windows Networking to suit the Ethernet network. 
4. Configure any other necessary parameters required for the office network. 

Note that assistance from the IT department responsible for the Ethernet network will normally be required. 

963 Installation Instructions TG201026 Issue 12, 02/04/2015 12 



Installation 

2.3 Install the 963 Software 
The installation of the 963 software is performed by a step-by-step installation program. During the installation 
procedure you will be required to enter the serial number for the software. This is located on the back of the case; 
you should keep this number in a safe place because it will be required when you purchase a licence. 

The installation will install SQL Server 2012 SP2 Express Edition with Tools operating in Mixed (SQL) mode if it 
is not already installed. If SQL Server MSDE is installed with the default instance, 963 will ask to upgrade it to SQL 
Server 2012 SP2 Express Edition with Tools. 

If SQL Server 2005 is installed with the MSSQLSERVER instance 963 will ask if the upgrade is to be carried out. If 
the upgrade is not performed it is necessary to install and configure SQL Server 2012 SP2 Express Edition with 
Tools as described in the 'Install SQL Server 2012 SP2 Express Edition with Tools’ and 'Configure SQL Server 
2012 SP2 Express Edition with Tools' sections of these instructions. 

If a full version of SQL Server 2012 SP2 is installed 963 informs the user that SQL Server must be correctly 
configured as described in the 'Configure a Full Version of SQL Server 2012 SP2' section of these instructions. 

If an earlier full version of SQL Server is installed a dialogue box is displayed to install SQL Server 2012 SP2 
manually. SQL Server 2012 SP2 must be installed and configured as described in the 'Install a Full Version of SQL 
Server 2012 SP2' and 'Configure a Full Version of SQL Server 2012 SP2' sections of these instructions. 

Make sure Windows Server 2008 has all latest windows updates installed prior 963 installation and no restarts are 
pending. 

When installing 963 on Windows Server 2008 R2 SP2, complete the following procedure. 

1. Ensure that all the latest updates from Windows are installed on the machine and there are no pending 
Windows update. 

2. Make sure that the user has the required access rights to install 963. To add the rights to the local 
administrator account: 
 Log on as Administrator. 
 Click Start>Run and type Control admintools. Click OK. The Administrative Tools page is 

displayed. 
 Double-click Local Security Policy. The Local Security Policy dialogue box is displayed. 
 Click Local Policies. In the right pane, double-click User Rights Assignment. A list of policies 

with security settings is displayed. 
 Double-click Backup Files and Directories. The Backup Files and Directories Properties 

dialogue box is displayed. 
 Click Add User or Group. The Select Users, Computers, Service Accounts, or Groups 

dialogue box is displayed. 
 Type the user account that is being used for setup and then click OK two times. 
 Repeat the procedure for the other two policies ie. Debug Programs and Manage auditing and 

security log from the Local Security Policy page. 
 On the File menu, click Exit to close the Local Security Policy dialogue box. 

3. Install 963 using the “Run as Administrator” command. 
 

To install the software: 
1. Log in to the PC as someone with Administrator rights. 
2. Insert the DVD into the disk drive, and wait for the installation screen to appear. 

Note that if autorun is disabled run SETUP.exe from the DVD. 

3. Follow the instructions on the screen. 
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2.4 SQL Server Installation and Configuration  
The information contained in this section is only required if a non standard installation of 963 or SQL Server is 
required or if an error occurs during a standard 963 installation which means that the 963 installation programme is 
unable to install SQL Server 2012 SP2 Express Edition with Tools. It contains information about installing SQL 
Server 2012 SP2 Express Edition with Tools, and configuring SQL Server 2012 SP2 Express Edition with Tools. It 
also describes installation and configuration of a full version of SQL Server 2012 SP2. 

2.4.1 SQL Server 2012 SP2 Express Edition with Tools 
2.4.1.1 Install SQL Server 2012 SP2 Express Edition with Tools 

To install SQL Server 2012 SP2 Express Edition with Tools: 
1. Log on to the PC as someone with Administrator rights. 
2. Install .NET 3.5 Service Pack 1 or/and .NET 4.0 as described in the `Install .NET Setup` section of this 

manual. 
3. Install Power Shell 2.0 as described in the `Install Power Shell 2.0` section of this manual. Not required for 

Windows 8 and Windows Server 2012 
4. Run the SQL Server 2012 SP2 Express Edition with Tools installation.  

32 Bit Operating Systems: 
 Run ‘SQLEXPR_x86_ENU.exe’ from the 'Support Files\Microsoft SQL Server 2012 SP2 Express 

Edition \32-bit' directory of the 963 installation DVD. 
64 Bit Operating Systems: 
 Run ‘SQLEXPR_x64_ENU.exe’ from the 'Support Files\Microsoft SQL Server 2012 SP2 Express 

Edition \64-bit' directory of the 963 installation DVD. 
Run ‘SQLManagementStudio_x86_ENU.exe’ from the 'Support Files\Microsoft SQL Server 2012 SP2 
Express Edition' directory of the 963 installation DVD. 

The SQL Server Installation Center screen is displayed. 

 
4. Click New installation or add features to an existing installation. The installation checks that the pre-

requisites are met. While this is being carried out a number of dialogue progress displays appear. If this is 
the case the License Terms screen is displayed. If not a dialogue box is displayed indicating the issue. 
These must be corrected before the installation can continue. 
 

5. Select the I accept the License terms check box. Only do this once you have read the terms and are 
agreeable. 
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6. Click Next>. The Setup Support Rules screen is displayed and the process is carried out. 

 
When it is complete the Installation Type screen is displayed. Continue with the default settings for the 
Installation Type screen.  

 
7. Click Next>. The License Terms page is displayed. 
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8. Select the ‘I accept the license terms’ checkbox after you have read and agreed with the terms. 
9. Click Next>. The Feature Selection screen is displayed.  

 

 
10. Click Select All. 
11. Click Next>. The Instance Configuration screen is displayed. 

 
12. Select the Named instance option and in the Instance ID box enter MSSQLSERVER. 
13. Click Next>. The installation checks the space requirement. If there is sufficient space the Server 

Configuration screen is displayed. 
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14. Under the Service Accounts tab, in the Account Name column of the SQL Server Database Engine row 
select NT AUTHORITY\SYSTEM. 

15. Click the Collation tab. 

 
16. Ensure that ‘SQL_Latin1_General_CP1_CI_AS’ is selected. If this is not the case click Customize and 

select Latin1_General from the Collation designator box in the displayed dialogue box. 
17. Click Next>. The Database Engine Configuration screen is displayed. 

 
18. Select the Mixed Mode (SQL Server authentication and Windows Authentication) option. 
19. In the Enter password box enter saTrend06. 
20. In the Confirm password box enter saTrend06. 
21. Click Next>. The Error reporting screen is displayed.  
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22. Click Next>. The installation process starts and the Installation Progress screen is displayed. When the 
installation is complete a success messages is displayed. 

 
23. Click Close. 

24. Click  to close the SQL Server Installation screen. 
25. Restart the PC.  
26. Configure SQL Server 2012 SP2 Express Edition with Tools as described in the 'Configure SQL Server 

2012 SP2 Express Edition with Tools' section of these instructions. 

2.4.1.2 Install .NET Setup 

In order to install SQL Server 2012 SP2 both .NET 3.5 Service Pack 1 and .NET 4.0 must be installed on the PC.  

To install .NET 3.5 service pack 1: 
1. Backup the PC. 
2. Close all programs. 
3. Log on the PC as someone with Administrator rights. 
4. Installation is possible using the Windows 8 DVD or the internet.  

Using the DVD 
 Insert the DVD into the disk drive. 
 Click Start> Run and type: 
  DISM /Online /Enable-Feature /FeatureName:NetFx3 /All /LimitAccess 

/Source:d:\sources\sxs 
 Click Enter. A confirmatory message is displayed post the successful installation of .Net 3.5. 

Via 963 installer setup 
 Click 963 installer to run the application. 
 A dialogue box prompts to Download and install the .NET 3.5 service pack 1 files. 
 Select this option. 
 Follow the instructions on the screen. A confirmatory message is displayed after the successful 

installation of .Net 3.5. 

Manually  
 Click Start> Control Panel> Programs and Features. 
 Click Turn Windows features on or off in the left panel. 
 Select the .Net Framework 3.5 (includes .Net 2.0 and 3.0) checkbox and click OK. A 

confirmatory message is displayed after the successful installation of .Net 3.5. 
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To install .NET 4.0: 

1. Backup the PC. 
2. Close all programs. 
3. Log on the PC as someone with Administrator rights. 
4. Installation is possible using the Windows 8 DVD or the internet.  

Using the DVD 
 Insert the DVD into the disk drive. 
 Click Start> Run and type: 
  DISM /Online /Enable-Feature /FeatureName:NetFx40 /All /LimitAccess 

/Source:d:\sources\sxs 
 Click Enter. A confirmatory message is displayed post the successful installation of .Net 4.0. 

Via 963 installer setup 
 Click 963 installer to run the application. 
 A dialogue box prompts to Download and install the .NET 4.0 files. 
 Select this option. 
 Follow the instructions on the screen. A confirmatory message is displayed after the successful 

installation of .Net 4.0. 

Manually  
 Click Start> Control Panel> Programs and Features. 
 Click Turn Windows features on or off in the left panel. 
 Select the .Net Framework 4.0 (includes .Net 2.0, 3.0, and 3.5) checkbox and click OK. A 

confirmatory message is displayed after the successful installation of .Net 4.0. 

Note that it is recommended to install .NET 4.0 updates after installing .NET 4.0. 

2.4.1.3 Install Power Shell 2.0 (Not applicable for Windows 7, Windows 8 and Windows Server 2012) 

In order to install SQL Server 2012 SP2 Express Edition with Tools Power Shell 2.0 must be installed on the PC.  

To install Power Shell 2.0: 
1. Backup the PC. 
2. Close all programs. 
3. Log on the PC as someone with Administrator rights. 
4. Copy the appropriate installation file for the operating system that is being used onto the PC see the table 

below. These file are located in the ‘Support Files\Power Shell 2.0’ folder of the 963 installation DVD. 

Operating System File to Use 
Windows Vista Business SP2 32-bit Windows6.0-KB968930-x86_WindowsVista.msu 
Windows Server 2008 SP2 32 bit Windows6.0-KB968930-x86_WindowsServer2008.msu 
Windows Server 2008 SP2 64 bit Windows6.0-KB968930-x64_WindowsServer2008.msu 

5. Run the file. The Software Update Installation Wizard is displayed. 
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6. Click Next>. The wizard changes. 

 
7. Select the I Agree option. Only do this once you have read the terms and are agreeable. 
8. Click Next>. The wizard changes and the installation starts. 

 
9. When the installation is complete the wizard changes to indicate this. 

 
10. Click Finish. 
11. Restart the PC.  
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2.4.1.4 Configure SQL Server 2012 SP2 Express Edition with Tools 

If SQL Server 2012 SP2 Express Edition with Tools has been installed manually as described in the 'Install SQL 
Server 2012 SP2 Express Edition with Tools' section of this manual it must be configured correctly so that 963 can 
be used. 

Note that this configuration is performed automatically if SQL Server 2012 SP2 Express Edition with Tools is 
installed by the 963's installation program. 

To configure SQL Server 2012 SP2 Express Edition with Tools: 
1. Ensure that the 963 is not running. 
2. Go to the Windows explorer, type, C:\ProgramData\Microsoft\Windows\Start Menu\Programs\Microsoft 

SQL Server 2012\Configuration Tools and click SQL Server Configuration Manager. The SQL Server 
Configuration Manager window is displayed. 

 
3. In the left pane expand SQL Server Network Configuration. 
4. In the left pane click Protocols for MSSQLSERVER. The screen changes. 

 
5. Right click Named Pipes and click Enable. A dialogue box is displayed, click OK. 
6. Right click TCP/IP and click Enable. A dialogue box is displayed, click OK. 
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7. In the pane click SQL Server Services. The screen changes. 

 
8. Right click SQL Server (MSSQLSERVER) and click Restart. 

9. Once the restart is complete click . 
10. On the Start menu, point to Microsoft SQL Server 2012, and click SQL Server Management Studio. 

The Connect to Server dialogue box is displayed. 

 
11. Ensure that `Windows Authentication` is selected in the Authentication mode box. 
12. Click Connect. The Microsoft SQL Server Management Studio window is displayed. 

 
13. In the left pane, right click top level of the navigation tree and select Facets. The View Facets window is 

displayed. 
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14. In the Facet box select Surface Area Configuration. The display changes. 
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15. Set `XPCmdShellEnabled` to be `True`.  
16. Click OK. 

17. Click  to close the Microsoft SQL Server Management Studio screen. 

2.4.2 SQL Server 2012 SP2 
2.4.2.1 Install a Full version of SQL Server 2012 SP2 

To install a full version of SQL Server 2012 SP2: 
1. Install SQL Server according to the instructions supplied by Microsoft®. During the installation you must 

ensure that the following information is configured. 

 Install all features. 
 SQL Server instance. The SQL Server can be installed using any instance, however Trend recommend 

MSSQLSERVER. 
 The built-in System account should be set to 'Local System'. 
 The SQL Browser service must be started at the end of set up. 
 Mixed Mode (Windows Authentication and SQL Server Authentication) must be used with a password 

of 'saTrend06'. 
 The currently logged on user must be added to the SQL Server Administrator role. 

2. For 963 to operate it is necessary to configure a Full Version of SQL Server 2012 SP2 as described in the 
'Configure SQL Server 2012 SP2 Express Edition with Tools' section of these instructions. 

Caution the operation should only be carried out by an SQL specialist. 

2.4.2.2 Configure a Full Version of SQL Server 2012 SP2 

If a full version of SQL Server has been installed manually as described in the 'Install a Full Version of SQL Server 
2012 SP2' section of this manual it must be configured correctly so that 963 can be used. 

To configure a full version of SQL Server 2012 SP2: 
1. Ensure that the 963 is not running. 
2. Following the instructions supplied by Microsoft® configure the following: 

 Enable 'Named Pipes'. 
 Enable 'xp_cmdshell'. 

If the SQL server is installed on a remote the following must also be configured. 

 Enable local and remote connections. 
 Enable both TCP/IP and named pipes for local and remote connections. 
 Set the SQL Browser service to start automatically. 

Caution the operation should only be carried out by an SQL specialist. 
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2.5 License 963 
Before 963 can be used, it must be licensed. The license will allow you to run 963 on a single PC. If you wish to run 
963 on another PC, another licence must be purchased, or the existing licence transferred to the other PC as 
described in the 'Transfer the Licence to a Different PC' section of these instructions. 

If 963 is already licensed, and you want to upgrade the licence to allow client/server operation, or more clients, 
contact us and purchase the appropriate upgrade. You will then be provided with a new site key that must be entered 
before the new facilities will be available. 

To licence 963: 
1. Obtain an unlock code as described in the ‘Obtain an Unlock Code’ section of these instructions. 
2. Enter the unlock code as described in the ‘Enter the Unlock Code’ section of these instructions. 

The 963 uses CrypKey to perform the licensing functions. CrypKey may not work after disk defragmentation using 
Speed Disk included in Norton utilities. This problem may exist with other defragmentation programs; see the 
‘Problems with Defragmentation Programs’ section of the 963 Engineering Manual (TE200637). 

The use of virus scanning and anti spyware programs may also cause problems with the licence as they may remove 
one of the CrypKey files, see the ‘Problems with Virus Scanning and Anti Spyware Programs’ section of the 963 
Engineering Manual (TE200637). 

2.5.1 Obtain an Unlock Code 
To licence 963 it is necessary to obtain an unlock code. 

To obtain an unlock code: 
1. Run 963. 
2. Log in as someone with a PIN level of 99. 
3. Press F1 to display the Information Centre. 

4. Click . The Licence Editor dialogue box is displayed. 

 
5. If it is not displayed in the Serial no box, enter the serial number. The serial number can be found on the 

back of the CD case. 
6. Click Licence 963. The Licence Details dialogue box is displayed. 
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7. In the Contact Name box enter your name. 
8. In the Company Name box enter your company name. 
9. In the Your Fax No box enter your fax number. 
10. In the Contact Number box enter a telephone number at which you can be contacted. 
11. In the Email box enter your email address. 
12. In the Site Name box enter the site on which 963 is to be installed. 
13. In the Site Address box enter the address of the site. 
14. Click OK. Notepad will now be run with the file 'faxform.txt'. 
15. On the File menu click Print in notepad to print out this file. 
16. Click Close. 
17. Go to https://partners.trendcontrols.com, login required. 
18. Follow the instructions to obtain the unlock code. If you have any problems contact our Customer Services 
Department:  Email: trendts@trendcontrols.com  Tel +44 (0)1403 226600. 

 

2.5.2 Enter the Unlock Code  
To enter the unlock code: 

1. Obtain an unlock code as described in the 'Obtain an Unlock Code' section of these instructions. 
2. Run 963. If the trial period has expired the Licence Editor dialogue box is displayed. If the trial period has 

not expired log in as someone with a PIN level of 99, press F1 to display the Information Centre, and 

click  to display the Licence Editor dialogue box. 

 
3. In the When you receive your site key, please type it in below box enter the unlock code either by 

clicking Format 1 and copying and pasting it into the box, or clicking Format 2 and typing it into the box. 
4. Click Update, a dialogue box is displayed informing you that the 963 has been licensed. If you want to 

view a text file containing detailed licence information is displayed click Yes, otherwise click No. 

Note that the text file containing detailed licence information is '963LicenceDetail.txt' store in the directory 
the 963 is installed in, and can be viewed in Notepad. 

5. Click Close. 

Note that the procedure described above can also be used to update the licence if it has changed. 

6. Restart the 963. 

If the 963 has been licensed with SMS Direct a dialogue box is displayed allowing the GSM connection to be 
configured click OK to configure the GSM Connection now, or Cancel to leave it until later. For details of 
configuring the connection see the ‘Configure the GSM Connection’ section of these instructions. 
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2.6 Configure 963 to launch under Non-Admin User (Applicable for Windows 7 
and 8 only) 

In the previous version of 963, admin login was required to run the 963 application (with 963 application pre-
installed). 

Performing the following steps enables the guest users/ non admin users to run/launch the 963 application (after the 
Admin has logged off). 

To launch 963 under a Non-Admin user: 
 

1. Log on to the PC as someone with Administrator rights. 
2. Ensure the start of the following  services at the system start-up:  

 Crypkey License  
 SQL Server (MSSQLSERVER) 

To check the service status: 
 Click Start >Run. 
 Type services.msc and click OK. 
 In the Services window: 

• Verify if the status for Crypkey License service is Started. Else, right-click Crypkey License 
and select Start. 

• Verify if the status for SQL Server (MSSQLSERVER) is Started. Else, right-click SQL 
Server (MSSQLSERVER) and select Start. 

 
3. Ensure that the following SQL Server protocols are enabled using SQL Server Configuration Manager tool: 

 Named Pipes 
 TCP/IP 

 
To enable SQL Server protocols 

• Click Start >Microsoft SQL Server 2012  SP2 > Configuration Tools > SQL Server 
Configuration Manager 

• View the SQL Server Network Configuration options and select Protocols for 
MSSQLSERVER 

• Verify if Named Pipes protocol status is Enabled. Else, right-click Named Pipes and select 
Enable. 

• Verify if TCP/IP protocol status is Enabled. Else, right-click TCP/IP and select Enable. 
 

4. Provide ‘Full control’ permission to 963 installed path for the users/group that will launch the 963.  
 

To provide full control to 963 installed path in Windows 7, perform the following steps: 

(Steps for other operating systems may differ slightly) 

 Go to the 963 installed path. (For example, C:\Program Files\Trend Control Systems). 
 Right-click the 963 folder and select Properties. The 963 Properties dialogue box appears. 
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 Select the Security tab and click Edit… to change the permissions. A Permissions dialogue box 
appears. 
 

 

 Click Add… to add a new user. 

 
 In the Select Users, Computers, Service Accounts or Groups dialogue box, perform the following 

steps: 
• For Locations, select Local Machine. 
• Type the user(s)/group name to which access has to be provided.   
• Click Check Names to verify the validity of the user/group name.  
• Click OK. 

  
 

 In the Permissions for 963 dialogue box, select the recently added user/group and select the Allow 
checkbox to provide Full Control permission. 
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 Click OK to save your changes.  

5. Provide ‘Full control’ permission to C:\ProgramData\Crypkey folder for the users/group that will launch 
the 963.  

 
To provide full control to C:\ProgramData\Crypkey folder in Windows 7, perform the following steps: 

(Steps for other operating systems may differ slightly) 

Note that by default the ProgramData is a hidden folder. Ensure that you modify the Folder Options to 
view the hidden files. 

 Go to the CrypKey folder. (For example, C:\ProgramData\CrypKey). 
 Right-click the CrypKey folder and select Properties. The CrypKey Properties dialogue box appears. 

 
 Select the Security tab and click Edit… to change the permissions.  
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 In the Permissions for CyprKey dialogue box, select the user/group that needs access to 963 and 
select the Allow checkbox to provide Full Control permission.  

 
 Click Apply to save your changes. 

6. Update the following database settings in “s2.ini” file. “s2.ini” file is located at 963 installed location. 
(Eg. C:\Program Files\Trend Control Systems\963\s2.ini). If [Database] section is missing then copy as 
shown below.  
Update the <server name> to database machine name. 

Update <963 database path> to location where 963 database is located. (eg. C:\Program Files\Trend 
Control Systems\963\database). 

[Database] 
Database=i96X 
Server=<server name> 
MixedMode=1 
DetachAfterShutdown=1 
Directory=<963 database path> 
Restore=0 
Username=sa 
Password=saTrend06 
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2.7 Configure 963 to Connect to a Remote SQL Server  
If required 963 can connect to a SQL Server (SQL Server 2012 SP2) on a different device this enables 963's 
database to be located on a network drive. 

To configure 963 to connect to a remote SQL Server: 
1. Run 963 and log in as some with System Administrator rights.  
2. On the Database menu click Properties. The Database Properties dialogue box is displayed. 
3. In the Current database server box specify the location of the SQL Server. If the default SQL instance 

has been used (MSSQLSERVER) it is only necessary to enter the name of the PC on which SQL Server is 
running. If a different instance name has been used the location of the SQL Server must be specified using 
the PC name and the instance name in the form shown below. 

<SQL Server PC name>\<instance name> 

<SQL Server PC name> specifies the name of the PC on the network on which the SQL Server is installed. 
<instance name> specifies instance name used to install the SQL Server. 

E.g. 

963\TREND963SQL 

This specifies a PC called 963 and a SQL instance of TREND963SQL. 

4. Click OK. A dialogue box is displayed reminding you that you need to restart 963. 
5. Click OK. 
6. Close 963. 
7. Run 963. If the database exists 963 will connect to it, if not a dialogue box is displayed informing you that 

it can't connect to the database, click Yes to enable 963 to create a new database. 

If the 963 is not able to connect to the remote SQL Server, check the following: 

 The ‘i96X’ database user is available in the remote SQL Server operating in SQL Server authentication 
mode with a password of ‘Trend963’. If it is not available create a user called `i96X` user as 
`sysadmin` user in the remote SQL Server with a password of `Trend963`. 

 It is possible to connect to the remote SQL Server using SQL Server Management Studio and the i96X 
user. 

 The files `i96X_data.mdf` and `i96X_log.ldf` are NOT in the 963`s project directory  

Caution the operation should only be carried out by an SQL specialist. 
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2.8 Connect the GSM Modem  
If 963 SMS Direct is being used it is necessary to connect the PC to the supplied GSM modem. The modem should 
be connected to the PC as described in the documentation supplied with the modem. Once the modem is connected 
to the PC the GSM connection must be configured as described in the ‘Configure the GSM Connection’ section of 
these instructions. 

Note that the GSM modem supplied with 963SMS Direct does not contain a SIM card. The SIM card should be 
obtained separately before connecting the GSM modem. 

To connect the GSM modem: 
1. Obtain and install a SIM card. 
2. Connect the GSM modem to the PC as described the supplied documentation. 

Do not install the mobile phone tools on the CD supplied in the modem package as they may interfere with 
the operation of 963 SMS. 
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2.9 Configure the GSM Connection 
If the 963 has been licensed with SMS direct it is necessary to configure the GSM connection that is to be used. The 
first time 963/…/SMS is run a dialogue box enabling the GSM connection to be configured is displayed. You can 
choose to configure it then, or it can be done later. The GSM connection can either be configured automatically or 
manually, as described in the ‘Configure the GSM Connection Automatically’, or ‘Configure the GSM Connection 
Manually’ sections of these instructions. 

When configuring the GSM connection it is recommended that any PIN requirement of the SIM be disabled, the use 
of PINs is NOT recommended. 963 does allow the use of PINs, however if the SIM card is swapped and an 
incorrect PIN number is present within the supervisor the SIM is likely to become locked. This is because 963 
attempts to unlock the SIM and after three incorrect attempts the SIM will be locked and a PUK number is required. 
963 keeps track of how many times the PIN is entered and will warn you if it thinks you are about to lock your SIM. 
The PUK is available from whatever mobile phone network you are using and can be unlocked using any standard 
mobile phone. 

If a pay as you go SIM is being used to send the alarms it is recommended that a scheduled event be set up to send a 
regular SMS message to keep the SIM active. Some pay as you go SIM cards will be deactivated by the provider if 
they are not used for a period of time. 

2.9.1 Configure the GSM Connection Automatically  
963 will scan all the PC’s COM ports looking for a GSM device if one is found it will be used. 

To configure the GSM connection automatically: 
1. Run 963 and log in as someone with authority to configure SMS settings. 
2. If the SMS Management dialogue box is not displayed on the SMS menu click Properties to display it. 

 
3. Click Test device. A dialogue box is displayed asking you to ensure the GSM modem is connected. 
4. Check the GSM modem is correctly connected to the PC and turned on. 
5. Click OK. The SMS Test dialogue box is displayed and 963 will scan all the COM ports to locate the 

GSM modem. The progress is reported in the dialogue box. To repeat the process click Retry. 
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6. Once the process is completed click OK to return to the SMS Management dialogue box. If 963 detects 
the GSM modem its details will be used. If the GSM modem was not correctly detected you can configure 
the connection manually as described in the ‘Manually Configure the GSM Connection’ section of these 
instructions. 

7. If a PIN is required to access the SIM enter the required PIN in the SIM PIN box. 

Caution: If the PIN is incorrect all SMS activity will cease until a correct PIN has been entered and 
activated. Incorrect entry of a PIN number may result in the SIM being locked requiring a PUK 
number from the network service provider. It is recommended that any requirement for entry of a 
PIN to activate the SIM is disabled. 

8. If text messages are to include international (UCS-2) characters select the Send as international 
characters (USC-2) check box. 

Note that if international characters are used only 70 characters are allowed in the SMS message. If 
international characters are not used the message can be up to 140 characters. 

9. If text messages are to flash on the phone to select the Send as Flash SMS check box. 
10. If an alarm is to be generated after a certain number of alarms have been sent select the Use message limit 

alarm check box, and in the Message alarm limit box enter the number of alarms that are sent before the 
message alarm limit alarm is generated. 

This alarm is useful if a pay as you go SIM is being used to send the alarms. The message alarm limit can 
be set to the number of alarms that can be sent using the available credit on the SIM. 

11. Click Apply. 963 will attempt to communicate with the modem to determine the manufacturer ID, and 
status. 

If successful the information will be displayed in the dialogue box. The signal strength is also displayed in 
the Signal area. If unsuccessful 963 will inform you that it was unable to configure the GSM connection. 
Failure could be because the COM port may be in use by another program. The manufacturer ID and status 
can be re detected by clicking Redect info. 

12. Click OK. 

2.9.2 Configure the GSM Connection Manually  
The GSM connection can be configured manually if for example the automatic configuration fails, or selects the 
wrong device if there is more than one. 

To configure the GSM connection manually: 
1. Run 963 and log in as someone with authority to configure SMS settings. 
2. If the SMS Management dialogue box is not displayed on the SMS menu click Properties to display it. 

 
3. In the COM port box click the COM port connecting the PC to the GSM modem. 
4. In the Baud rate box click the baud rate for communications between the modem and PC. 
5. If a PIN is required to access the SIM enter the required PIN in the SIM PIN box. 

Caution: If the PIN is incorrect all SMS activity will cease until a correct PIN has been entered and 
activated. Incorrect entry of a PIN number may result in the SIM being locked requiring a PUK 
number from the network service provider. It is recommended that any requirement for entry of a 
PIN to activate the SIM is disabled. 

963 Installation Instructions TG201026 Issue 12, 2-April-2015 35 



Installation 

6. If text messages are to include international (UCS-2) characters select the Send as international 
characters (USC-2) check box. 

Note that if international characters are used only 70 characters are allowed in the SMS message. If 
international characters are not used the message can be up to 140 characters. 

7. If text messages are to flash on the phone to select the Send as Flash SMS check box. 
8. If an alarm is to be generated after a certain number of alarms have been sent select the Use message limit 

alarm check box, and in the Message alarm limit box enter the number of alarms that are sent before the 
message alarm limit alarm is generated. 

This alarm is useful if a pay as you go SIM is being used to send the alarms. The message alarm limit can 
be set to the number of alarms that can be sent using the available credit on the SIM. 

9. Click Apply. 963 will attempt to communicate with the modem to determine the manufacturer ID, and 
status. 

If successful the information will be displayed in the dialogue box. The signal strength is also displayed in 
the Signal area. If required the manufacturer ID, and status can be re detected by clicking Redect info. 

10. Click OK. 
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2.10 Connect to the IQ Network 
2.10.1 Connect over Ethernet 
963 can be connected to the IQ network over Ethernet using a standard Ethernet connection; this allows the office IT 
network to be used to connect 963 to the IQ network. Connecting 963 in this way requires a virtual CNC operating 
in supervisor mode. The device containing the vCNC should be selected according to the type of access that is 
required. 

 Casual access to point data for general browsing of the system can be carried out through any vCNC. 
 Time critical, or densely populated displays of data (such as Schematic pages on fast refresh rates, or with 

more than 20 points per page) are recommended to be used on vCNC’s in either an XTEND or IQ3/IQ4 
controller with no significant control strategy in them (e.g. an IQ3Xact placed in the system solely as a 
vCNC access point). 

 Where the highest level of performance is required and/or multiple vCNC connections are required then a 
XTEND should be used. 

To connect 963 to the IQ network over Ethernet: 
1. Ensure the PC is connected to the Ethernet network as described in the 'Connect the PC to the Ethernet 

Network' section of this manual. 
2. Run 963. 
3. Log in as someone who can display the Communications Window. 
4. Press F1 to display the Information Centre. 
5. Click . The Communications Window will be displayed. 
6. Click Configure Comms. The Local Site Connection Setup dialogue box is displayed. 

 
7. Click TCP/IP. 
8. In the IP Address or hostname box enter the IP address or hostname of the device containing the virtual 

CNC to which 963 is to connect. The hostname must be entered in quotes e.g. "Boilers". 

Note that a hostname should be used if a DHCP server is being used on the system to setup the IP settings 
of the device containing the virtual CNC. You should also remember that XTEND's, and IQ3 controllers 
earlier than v1.3 do not support hostname addressing. 

9. In the Port Scan From box enter the port number of the first vCNC in the range of vCNCs to which 963 
can connect (e.g. 10005). 

10. In the Port Scan To box enter the port number of the last vCNC in the range of vCNCs to which 963 can 
connect (e.g. 10006). 

11. In the Site GUID box enter the machine-readable site code for the site. The machine-readable site code 
must be enclosed in curly brackets ({}) 

963 will be able to connect to the IQ network using any of the ports in the specified range. Because each 
port has a specific address on the IQ network, the address of 963 on the IQ network will vary depending on 
which port it uses. 

If alarms are to be sent to 963 through this device, the top and bottom of the range must be the same 
to ensure the same network address is used each time 963 is started. 

12. If 963 is to only access remote TCP/IP sites select the Click here if you have no local site 
communications check box. 

13. Click OK. 
14. Restart 963. 

Note that if the device containing the virtual CNC goes into link/local mode (e.g. DHCP server fails) the 963s 
connection to the IQ network will be lost. This is expected behaviour if the PC is on the same network segment as 
the device containing the virtual CNC restart the PC. If the device is on a different subnet it will be necessary to fix 
the problem that caused the device to go into link/local mode. 
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2.10.2 Connect over the Current Loop  
963 can be connected the IQ network over the IQ current loop using a NBOX/CNC2, which must be purchased 
separately. 

To connect to the IQ network over the current loop: 
1. Ensure the 963 is not running. 
2. Install the NBOX/CNC2 as described in the supplied installation instructions and connect it to the PC 

running 963. 
3. Run 963. It will automatically detect the communications speed between its serial port and the 

NBOX/CNC2 used for this communication. 

If this automatic detection fails the communications settings can be configured manually. 

To configure the communications setting manually: 
1. Log in as someone who can display the Communications Window. 
2. Press F1 to display the Information Centre. 
3. Click . The Communications Window will be displayed. 
4. Click Configure Comms. The Local Site Connection Setup dialogue box is displayed. 

 
5. Click Specific COM Port and enter the required COM port number. Clicking Auto Scan Com Port will 

cause 963 to find the port that is connected to the NBOX/CNC2 automatically which is the default, and 
should only be changed if there are communication problems. 

6. Click OK. 
7. Restart 963. 
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2.11 Check Communications  
Once 963 is connected to the IQ network it is advisable to check that the communications are working correctly by 
looking at the Basic Communications Display, shown below. The display appears at the bottom of 963’s window. 
It provides information about the status of communications in and out of the node connecting 963 to the IQ network, 
and the status of any remote connection devices on the system. 

 

TX and RX indicators: These flash green when 963 receives, or transmits information. If they appear grey, 
the 963 has been unable to locate the CNC. 

Remote connection indicator: If grey, all of the devices are available for use, if red, at least one of them is 
attempting to make a connection, and if green, at least one is connected. Clicking this icon displays the Remote 
Connection Window. 
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2.12 Configure the Windows User to have Access to SQL Server  
The Windows users that are to run 963 must have access to SQL Server. If the user is an 'Administrator' user (is a 
member of the 'Administrator' workgroup) it will have access to SQL Server and no additional configuration is 
necessary. However if the user is not is a member of the 'Administrator' workgroup it is necessary to give the user 
access to SQL Server. This can be done by either making the user a power user (in the 'Power Users' Windows 
workgroup) and setting 963 to connect to SQL Server in SQL Server Authentication mode, or giving the user access 
to SQL Server, and connecting to SQL Server in Windows authentication mode, this is the more secure option, but 
requires more configuration. 

To make the user a power user and set 963 to connect to SQL Server in SQL Server Authentication mode: 
1. Log in to the PC as someone with Administrator rights. 
2. Add the user to the 'Power Users' Windows workgroup. For details about configuring Windows user 

accounts and workgroups see appropriate operating systems documentation. 
3. Run 963. 
4. Log in as some with System Administrator rights.  
5. On the Database menu click Properties. The Database Properties dialogue box is displayed. 

 
6. Select the Using SQL Server Authentication check box in the Connect to SQL Server area. 
7. Click OK. 
8. Close 963. 

To give the user access to SQL Server and set 963 to connect to SQL Server in Windows Authentication 
mode: 

1. Log in to the PC as someone with Administrator rights. 
2. Give the user access to SQL Server by adding the user to the ‘SQLSERVER2005MSSQLUSERS$<xxxx>’ 

Windows workgroup. Where <xxxx> is the PC name. This group is created when SQL Server is installed. 
See the SQL Server documentation for details. For details about configuring Windows user accounts and 
workgroups see appropriate operating systems documentation. 

3. By default 963 connects to SQL Server in Windows Authentication mode. To check this is the case, ensure 
that the Using SQL Server Authentication check box in the Connect to SQL Server area of the 
Database Properties dialogue box is cleared. 
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2.13 Install a Language Version not available in the Installation Program  
Some language variants cannot be installed using the 963 installation program. These languages can be installed 
following the procedure below: 

Install a language version not available in the installation program: 
1. Install 963 as described in the 'Installation Procedures' section of this manual. 
2. Ensure that 963 is not running. 
3. Copy the following files for the required language from the appropriate directory on the 963 DVD into the 

963 install directory (normally c:\program files\trend control systems\963). There is a directory for each 
language that can be installed in this way in the Support Files\Translations directory of the 963 DVD. 
S2RES.DLL 
Tcomsrv.dll 
ToolkitPro.Resource*.dll 
 

4. Copy the following javascript files for the required language from the appropriate directory on the 963 
DVD into the 963 install javascript directory (normally c:\program files\trend control 
systems\963\HTML\js).There is a directory for each language that can be installed in this way in the 
Support Files\Translations directory of the 963 DVD. 
StringResource.js 
jquery.ui.datepicker-settings.js 
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2.14 Support for Virtualisation and Operation as a Service  
963 can be installed along with 3rd party software to provide a fault tolerant high availability solution using, both a 
'Service Wrapper' & 'Virtualisation'. 

Operation as a Service 
963 cannot run as a native service however 963 v3.71 has been tested to operate using a service wrapper (AlwaysUp 
v8.5).  

The service wrapper wraps up the application within a service environment monitoring it constantly to ensure 100% 
uptime. It will automatically start the 963 application when the PC starts ensuring 24/7 availability of the software. 

Operation in a Virtual Environment 
963 v3.71 has been tested to operate in a virtual environment (virtualisation) which can used to either reduce 
hardware requirements (server consolidation) or provide a high availability / fault tolerant system. 

Virtualization is supported using the virtual environment software VMware vSphere v5.1. This software uses the 
concept of clustered servers/ server consolidation ensuring that the virtual environment is switched across to an 
alternative server in case of a hardware failure.  

Important: Running 963 as a service or in a virtual environment requires additional 3rd party software. Please 
consult an IT specialist with expertise in these types of solution to ensure the system is correctly configured.  
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3 UPGRADE 
3.1 Upgrade 963  
In most situations upgrading form an earlier version of 963 will simply be a matter of inserting the 963 DVD and 
following the instructions on the screen. The existing version of 963 will be upgraded to the latest version, and the 
963's database updated accordingly. There should be no need to re-licence 963. 

Note that there was an error in earlier installations of 963 which meant that clicking the ? on a schematic page did 
not run the user guide. This has been corrected for new installs of 963 in v3.40. However in order to preserve any 
schematic pages that have been created the upgrade does not overwrite the existing schematic pages. The issue can 
be corrected by performing a find and replace on the schematic pages to find 'WINEXEC winhlp32.exe 
<DATA>\documentation\963 user guide.hlp' and replace it with 'WINEXEC hh.exe <DATA>\documentation\963-
User-Guide.chm'. 

In the following circumstances it will be necessary to follow a different installation procedure. 

 Upgrading a 963 where the 963's database is running on a remote SQL Server (i.e. on another PC). See the 
'Upgrade 963 when the Database is on a Remote PC' section of this manual for details. 

 Upgrading from 963 v1.x or 962 it may be necessary to check the SQL queries. See the 'Upgrade from 
963v1.x or 962' section of this manual for details. 

3.1.1 Upgrade 963 when the Database is on a Remote PC  
If upgrading a 963 where the 963's database is running on a remote SQL Server (i.e. on another PC) the installation 
program will not be able to perform the necessary updates to the 963's database on the remote PC therefore it will be 
necessary to manually upgrade the 963 database on the remote PC. 

To upgrade 963 when the database is on a remote PC: 
1. If necessary upgrade the SQL Server to SQL Server 2012 SP2 Express Edition with Tools as described in 

the `Upgrade SQL Server 2012 SP2 Express Edition with Tools` and ‘Upgrade SQL Server 2012 SP2’ 
sections of this manual. 
If a full version of SQL Server is installed it must be upgraded to SQL Server 2012 SP2 following the 
instructions supplied by Microsoft. 

2. Run 963. 
3. Log in to the PC as someone with Administrator rights. 
4. On the Database menu click Properties. The Database Properties dialogue box is displayed. 

 
5. Select the Detach database after supervisor has been shutdown check box. 
6. Click OK. 
7. Close 963. 
8. Backup the database files, and any other data files before upgrading 963. 
9. Upgrade the 963 on the 963 PC ensuring that the 963 is installed in the same directory as original 963 as 

described in the 'Install the 963 Software' section of this manual. 
10. Do not run 963. 
11. Copy the 963 database files (mdf and ldf files in the C:\Program Files\Trend Control Systems\963\database 

directory) from the remote PC to the same location on the 963 PC. 
12. Run notepad, and open the S2.INI file in the install directory (normally c:\program files\trend control 

systems\963). 

Note that if the 963 is running on Windows Vista™ or Windows 7 you must run notepad with administrator 
rights. This will require you to have access to a password for a Windows user with administrator rights. 

12. Search through the file to find the following line: 
[DATABASE] 
Server= 

13. Make a note of the 'Server=' setting you will need it later. 
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14. Change the 'Server=' setting to '.' so 963 uses the local database files as shown below. 
Server=. 

15. Run 963. The local database files will be updated. 
16. Close 963. 
17. Copy the 963 database files (mdf and ldf files in the C:\Program Files\Trend Control Systems\963\database 

directory) from the 963 PC to the same location on the remote PC. 
18. Set the 'Server=' setting in the [DATABASE] section of S2.INI file back to the original setting before it 

was changed in step (15). 
19. Run 963. 

3.1.2 Upgrade from 963 v1.x or 962 
If 963 v1.x or 962 has been installed and engineered on the PC, it is possible to upgrade to the latest version of 963 
without having to re-engineer the system. However a new licence is required to enable 963 to run if upgrading from 
962. The upgrade process will make a backup of the previous system so that if you decide not to purchase 963 it is 
possible to return to the original system. 

Note that historic alarms are not imported from the old 963 database. However they can still be viewed by viewing 
historic records, and specifying the old database. Schematic pages in version 2 are not backwards compatible with 
version 1. Therefore if pages are required to run in both version 1 and version 2 they must be engineered with 963 
v1. 

To upgrade from 963 v1.x or 962: 
1. Backup the database files, and any other data files before upgrading 963. 
2. If installing 963 on a PC that has a full installation of SQL Server earlier than SQL Server 2012 SP2 it is 

necessary to upgrade to SQL Server 2012 SP2 as described in the `Upgrade SQL Server 2012 SP2 ` section 
of this manual. 

3. If SQL Server has been prevented from performing command execution this must be re-enabled, see the 
'Restrict SQL Servers Ability to Perform Command Execution' section of the 963 Engineering Manual 
(TE200637). 

4. Close 963 or 962. 
5. Install 963 as described earlier in this section ensuring that the 963 is installed in the same directory as 

original 963 or 962. 
6. If the old configuration uses the VIEWQUERY, QUERYTOTEXTFILE, or PRINTQUERY actions it is 

recommended that you check the SQL queries to ensure that they work correctly and if necessary fix the 
problem as described in the ‘Check SQL Queries’ section of these instructions. 

7. Alarm actions configured for a specific point are no longer supported a suitable alarm filter and alarm 
group should be configured instead. 

3.1.2.1 Check SQL Queries  

If upgrading from a version of 963 earlier than v2.1 that uses the VIEWQUERY, QUERYTOTEXTFILE, or 
PRINTQUERY actions it is recommended that you locate the places they are use and ensure that they work 
correctly and if necessary fix the problem. This is because the database format used by v2.1 is different from earlier 
versions of 963 and therefore these actions may now fail. Theses action can be used on schematic pages, alarms 
actions, and in scheduled events. Some tools have been provided help you locate the places these actions are being 
used. Once you locate where these actions are used you should check each one in turn to ensure that it works 
correctly, and if not modify the SQL. For details of the 963’s database structure see the ‘Databases’ section of the 
963 Engineering Manual (TE200637). 

To check the SQL queries: 
1.  Run 963 and log in as a user who can access Tool menu. 
2. On the Tools menu point to Search SQL From and then click Schematics, Scheduler, or Alarms 

depending on which area of the 963 is to be searched. It may be necessary to search all three areas. 
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If Schematics was selected the Find SQL on Schematic dialogue box is displayed. 

 
 In the Select action to find box select the action that you want to search for. To search for all three 

actions select All. 
 In the Search Options area select the schematic pages that are to be searched. Click Search current 

schematic/folder to search the folder selected in the Navigator, or Search all schematics to search all 
schematics. 

 To create a log file of the search results select the Generate log file check box. 
 To prevent the search results being displayed in the Results box clear the View Results check box. 
 Click Find. The search will be carried out. If the View Results check box is selected the results will be 

displayed in the Results box. To goto to a schematic page that has matched the search click it in the 
Results box and click GOTO Selected Page. 

If Scheduler was selected a dialogue box listing any scheduled events that use the VIEWQUERY, 
QUERYTOTEXTFILE, or PRINTQUERY actions. 

If Alarms was selected a dialogue box listing any alarm actions that use the VIEWQUERY, 
QUERYTOTEXTFILE, or PRINTQUERY actions. 

3.1.3 Return to the Original 963 System  
When you upgrade from an earlier version of 963, or 962 a backup of the system is made in a subdirectory of the 
install directory called 963_backup, or 962_backup. This means that if you decide not to use the latest version of 
963 it is possible to return to the original system. 

To return to the original system: 
1. Copy the entire contents of the backup directory Backups into the install directory, normally c:\program 

files\trend control systems\963 or c:\program files\trend control systems\962. 
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3.2 Upgrade to SQL Server 2012 SP2 Express Edition with Tools 
Different versions of 963 were supplied with different version of SQL. Therefore when manually upgrading SQL 
Server to SQL Server 2012 SP2 Express Edition with Tools it is necessary to follow the appropriate instructions see 
the table below. 

963 Version Upgrade Path 
3.71 No upgrade required.  
v3.62 Upgrade to SQL Server 2012 SP2 Express Edition with Tools from SQL Server 2008 R2 

Express Edition  
Ensure that you upgrade SQL Server 2008 to SQL Server 2008 SP1 before upgrading to SQL Server 
2012 SP 2.  
Based on your OS type, select either 64 bit or 32 bit. 
 

v3.60  Upgrade to SQL Server 2012 SP2 Express Edition with Tools from SQL Server 2008 Express 
Edition  
Ensure that you upgrade SQL Server 2008 to SQL Server 2008 SP1 before upgrading to SQL Server 
2012 SP 2.  
Based on your OS type, select either 64 bit or 32 bit. 

v3.50  

v3.40  

v3.30 Upgrade to SQL Server 2012 SP2 Express Edition with Tools from SQL Server 2005   
Ensure that you upgrade to SQL Server 2005 SP4 before upgrading to SQL Server 2012 SP2. 
 

v3.20 
v3.10 
v3.01 
v3.00 
v2.20 
v2.12 Direct upgrade not supported.  

Recommended to upgrade to 963 v3.62 (refer the 963 v3.62 Installation Manual) followed by 
upgrade to 963 v3.71 

v2.10 
v2.0 
 
3.2.1 Upgrading to SQL Server 2012 SP2 Express Edition with Tools from SQL Server 2005 
This process should be used to upgrade the database engine (SQL Server 2005 Express Edition) supplied with 
versions v3.30, v3.20, v3.10, v3.01, and v3.00 of 963 to SQL Server 2012 SP2 Express Edition with Tools. The 
steps described below assume that SQL Server 2005 Express Edition is installed with the default instance 
(MSSQLSERVER) and the computer is 32 bit. 

To upgrade SQL Server 2012 SP2 Express Edition with Tools from SQL Server 2005 Express Edition: 
1. Backup the PC. 
2. Close all programs. Log on the PC as someone with Administrator rights. 
3. Ensure 963 is not running. 
4. Install .Net 3.5 SP1, .Net4.0, and, .net 4.0 updates as described in ‘Install .NET Setup’ section of this 

manual. 
5. Install Power Shell 2.0 as described in the `Install Power Shell 2.0` section of this manual. Not required for 

Windows 7, Windows 8, and Windows Server 2012. 
6. Install SQL Server 2005 SP4. Run ‘SQL2005_SP4_SQLEXPR_ADV.Exe’ from the 963 installation DVD. 
7. The End User License Agreement dialogue box is displayed. Check the I accept... check box and click 

Next. 
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8. The Installing Prerequisites screen is displayed. Click Install to continue. 

 
9. After the required components are installed, click Next. 
10. The System Configuration Check window is displayed. Once the configurations are verified click Next. 
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11. The Welcome to the Microsoft SQL Server Installation Wizard screen is displayed. Click Next to 
continue. 

 
12. The set up screen is displayed. Type the Name and the Company.  

 
13. Click Next. The Feature Selection screen is displayed. Make the appropriate selection and click Next.  
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14. The Authentication Mode screen is displayed. It is recommended to use the Windows Authentication 
Mode. 

 
15. Click Next. The Configuration Options screen is displayed. Check the Enable User Instances option and 

click Next. 
16. The Error and Usage Report Settings screen is displayed. Select the required option and click Next. You 

can proceed without making a selection as well. 
17. The Ready to Install screen is displayed. Click Install to start the installation. 

 
18. After the setup is complete for the required components, click Next. 
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19. The completion screen is displayed after the installation is complete. 

 
20. Click Finish to close the screen. 
21. Install SQL Server 2012 Engine. Run ‘SQLEXPR_x86_ENU.Exe’ from the 963 installation DVD. 
22. The SQL Server Installation screen is displayed. Select Upgrade from SQL Server 2005, SQL Server 

2008 or SQL Server 2008 R2. 

 
23. The Setup Support Rules screen is displayed showing the progress. 

 
24. Click OK once the check is completed.  
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25. The License Terms screen is displayed. Select the I accept the License terms check box and click Next. 

  
26. Click Next. The Product Updates screen is displayed. You can choose to skip the scan at any point and 

click Next to continue. 

 
27. The Install Setup Files screen is displayed. Click Install to continue. 
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28. The Setup Support Rules screen is displayed. Click Next to continue.  

 
29. The License Terms screen is displayed. Select the I accept the License terms check box and click Next. 

 
30. On the Select Instance screen, select the MSSQLSERVER from the drop down list. 

 
31. Click Next. Perform all the actions as described in the Setup wizard. 
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32. After the installation is complete, a Complete screen is displayed. 

 
33. Install SQL Server 2012 Management Studio. Run SQLManagementStudio_x86_ENU.exe from the 963 

installation DVD. 
34. Install the SQL Server 2012 Management Studio as described in the ‘Installing SQL Server 2012 

Management Studio’. 

3.2.2 Upgrading to SQL Server 2012 SP2 Express edition with Tools from SQL Server 2008 R2 
Express edition 

This process should be used to upgrade the database engine (SQL Server 2008 R2 Express Edition) supplied with 
versions v3.62, v3.6, v3.5, and v3.4 of 963 to SQL Server 2012 SP2 Express Edition with Tools. The steps 
described below assume that SQL Server 2008 R2 Express Edition is installed with the default instance 
(MSSQLSERVER) and the computer is 64 bit. 

To upgrade SQL Server 2012 SP2 Express Edition with Tools from SQL Server 2008 R2 Express Edition: 
1. Backup the PC. 
2. Close all programs. 
3. Log on the PC as someone with Administrator rights. 
4. Ensure 963 is not running. 
5. Install .Net 4.0 and .net 4.0 updates as described in the ‘Install .NET Setup’ section of this manual. 
6. Run ‘SQLSERVER2008R2SP1_KB2528583_x64_ENU.exe’ from the 963 installation DVD. 
7. The SQL Server 2008 R2 update screen is displayed. 
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8. Click Next to continue. The License Terms screen is displayed.  

 
9. Check the I accept the license terms check box. Click Next to continue. 
10. The Select Features screen is displayed. Select the required features and click Next to continue. 

 
11. Click Next to continue on the next few screens. Once the update is complete, the Complete screen is 

displayed. 

 
12.  Install SQL Server 2012 Engine. Run ‘SQLEXPR_x64_ENU.Exe’ from the 963 installation DVD. 
13. The SQL Server Installation screen is displayed. Select Upgrade from SQL Server 2005, SQL Server 

2008 or SQL Server 2008 R2. 

For the remaining steps refer to ‘Upgrading to SQL Server 2012 SP2 Express Edition with Tools from SQL 
Server 2005’ step 21 onwards. However, ensure that you run SQLEXPR_x64_ENU.Exe’ from the 963 
installation DVD. 
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3.2.3 Installing SQL Server 2012 Management Studio 
SQL Server 2012 Management Studio can be installed once the SQL engine has been successfully installed. 

To install the SQL Server 2012 Management Studio: 
1. Backup the PC. 
2. Close all programs. 
3. Log on the PC as someone with Administrator rights. 
4. Ensure 963 is not running. 
5. Run ‘SQLManagementStudio_x86_ENU.exe’ from the 963 installation DVD. 
6. The SQL Server Installation Center screen is displayed. 

 
7. Select the New SQL Server stand-alone installation or add features to an existing installation option. 
8. The License Terms screen is displayed. Accept the license terms and click Next. 

 
9. The Product Updates screen is displayed. Check the Include SQL Server Product Updates if you 

require the updates. Click Next. 
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10. The Installation Type screen is displayed. Select the Perform a new installation of SQL Server 2012 
option and click Next. 

 
11. The Feature Selection screen is displayed. Select the features and click Next. 

 
12. The Error Reporting screen is displayed. Click Next to continue. 

 
13. The Installation Progress screen is displayed showing the installation progress. 
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14. Once the installation is complete, the Complete screen is displayed.  

 
Note that it is recommended to reboot your computer after the installation is complete. 

3.2.4 Transfer the Licence to a Different Location  
If you want to use your 963 licence to run 963 in a different location e.g. on a different PC, or in a different 
directory, it is necessary to transfer the licence to that location. 

To transfer the licence: 
1. Install 963 in the new location as described in the 'Install the 963 Software' section of these instructions. 
2. Run 963 in the new location. 
3. Log in as someone with a PIN level of 99. 
4. Press F1 to display the Information Centre. 

5. Click . The Licence Editor dialogue box is displayed. 

 
6. If transferring the licence to a different PC connect the removable media that is to be used to transfer the 

licence. 

Note that this has been tested on floppy disk, USB flash disk. Trend cannot guarantee that other removable 
media type will work. 

7. Click Register transfer. The Browse for Folder dialogue box is displayed. 

963 Installation Instructions TG201026 Issue 12, 2-April-2015 57 



Upgrade 

 
8. Click the location to which the licence is to be copied. If moving the licence to a different PC this is the 

removable media. To create a new folder click Make New Folder. 
9. Click OK. The Are you sure? dialogue box is displayed. 
10. Click OK. 
11. If transferring the licence to a different PC remove the removable media. 
12. Run 963 the currently licensed 963. 
13. Log on as someone with a PIN level of 99. 
14. Press F1 to display the Information Centre. 

15. Click . The Licence Editor dialogue box is displayed. 
16. If transferring the licence to a different PC connect the removable media being used to transfer the licence. 
17. Click Transfer Out. The Browse for Folder dialogue box is displayed. 
18. Click the location specified in (8). 
19. Click OK. The Are you sure? dialogue box is displayed. 
20. Click OK. The licence will be moved to the specified location. The 963 is no longer licensed to run in that 

location. 
21. Run 963 in the new location. 
22. Log on as someone with a PIN level of 99. 
23. Press F1 to display the Information Centre. 

24. Click . The Licence Editor dialogue box is displayed. 
25. If transferring the licence to a different PC connect the removable media being used to transfer the licence. 
26. Click Transfer In. The Browse for Folder dialogue box is displayed. 

Note that if Transfer In is not available, it is necessary to delete the ‘s2.key’ in the install directory. 

27. Click the location where the licence has been stored in (8). Click OK. The Are you sure? dialogue box is 
displayed. 

28. Click OK. The licence will be moved to the new location. The 963 is now licensed to run in the new 
location. 

29. Click Close. 
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4 HTTPS WEB SERVER SETTINGS 
963 now operates on a secure protocol, SSL (https). This means a certificate must be provided to ensure that the web 
server connection is secure. This certificate can either be purchased online or a self signed certificate can be 
generated. 963 provides a utility to create a self signed certificate as well. 

Refer to the Engineering Manual (TE200637) for a detailed procedure on how to import, export, and generate a self 
signed certificate.  
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